
 

 

 

 

 

 

UniVert 
Mechanical Test System 

 

 

 

User Manual  

version 1.7 

 

  



 

 

 

 

 

Mechanical measurement and analysis of materials 

 

CellScale provides scientific and medical researchers with turn-key systems for 
measuring the mechanical properties of materials. We provide user-friendly 
software, an easy-to-use patented attachment system and effective data analysis 
tools.  

Our foundation was laid at one of the world’s leading research institutions – The 
University of Waterloo. We understand research and aim to provide effective 
solutions at a reasonable price.  

Explore our web site www.cellscale.com or contact us to learn more about our 
measurement systems. 

© 2016 CellScale. All rights reserved. This material may not be reproduced, 
displayed, modified or distributed without the express prior written permission of the 
copyright holder. For permission, contact CellScale Biomaterials Testing at 
info@cellscale.com. 

 

 
Sales and Support 

CellScale Biomaterials Testing 
11–564 Weber St. N. 

Waterloo, Ontario, Canada N2L 5C6 
Phone: 519.342.6870 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

http://www.cellscale.com/
mailto:info@cellscale.com


 

 

 

Table of Contents 

1. General Information .................................................................................................................. 1 

Environmental and Electrical Specifications ................................................................................ 1 

System Assembly......................................................................................................................... 1 

Connections to Supply ................................................................................................................. 1 

Safety Warnings ........................................................................................................................... 2 

Manual Operating Controls .......................................................................................................... 2 

General Maintenance ................................................................................................................... 2 

Approvals and Certification .......................................................................................................... 2 

2. Testing Terminology ................................................................................................................. 3 

Multiphase Test Cycles ................................................................................................................ 3 

Phases, Cycles, and Test Sequences ......................................................................................... 4 

Test Phases: The Smallest Unit of Testing .................................................................................. 5 

Control Modes .............................................................................................................................. 5 

Control Functions ......................................................................................................................... 5 

Test Modes .................................................................................................................................. 6 

3. Software Overview ................................................................................................................... 7 

Output Files and Data Structures................................................................................................. 8 

4. Setting Up & Starting a Test ..................................................................................................... 9 

Overview ...................................................................................................................................... 9 

Step 1: Start a New Test .............................................................................................................. 9 

Step 2: Reset the Actuator ......................................................................................................... 10 

Step 3: Specify Test Type .......................................................................................................... 11 

Step 4: Move the Actuator to a Specified Size .......................................................................... 11 

Step 5: Zero the Load Cell (occasionally) .................................................................................. 12 

Step 6: Modify Testing Parameters (optional) ........................................................................... 12 

Step 7: Mounting a Specimen .................................................................................................... 14 

Platen Mounted Specimens ................................................................................................... 14 

Grip Mounted Specimens: ...................................................................................................... 15 

3-point Bend Specimens ........................................................................................................ 17 

Step 8: Execute the Test ............................................................................................................ 19 

Step 9: Terminate the Test Prematurely (optional) .................................................................... 19 

5. Additional Settings .................................................................................................................. 20 

Configuring Output Data Files .................................................................................................... 20 

Advanced System Settings Dialogue ......................................................................................... 21 

Range Limits .............................................................................................................................. 23 



 

 

 

Configuring the Live Charting Graphs ....................................................................................... 24 

6. Reviewing Test Results .......................................................................................................... 26 

Overview .................................................................................................................................... 26 

Selecting Images........................................................................................................................ 27 

Image Playback Options ............................................................................................................ 27 

Image Tracking: Overview ......................................................................................................... 28 

Image Tracking: The Points Display Option .............................................................................. 31 

Image Tracking: The Displacement Option ............................................................................... 32 

Image Tracking: The Strains Option .......................................................................................... 33 

Data Overlay .............................................................................................................................. 34 

Exporting Tracked Data ............................................................................................................. 35 

Exporting Images and Movies .................................................................................................... 36 

7. System Hardware Settings ..................................................................................................... 37 

Controller .................................................................................................................................... 37 

Camera ...................................................................................................................................... 37 

Load Cell .................................................................................................................................... 38 

Actuator and Motor .................................................................................................................... 39 

8. System Calibration and Advanced Tools ............................................................................... 40 

Load Cell Calibration .................................................................................................................. 40 

Alternate Method .................................................................................................................... 43 

Zero Position Calibration ............................................................................................................ 45 

System Stiffness Compensation ................................................................................................ 49 

Snap Image Feature .................................................................................................................. 52 

Update Firmware........................................................................................................................ 52 

9. Troubleshooting ...................................................................................................................... 53 

Communication Errors: Read File failed with error 6. ................................................................ 53 

Actuator Limits ........................................................................................................................... 54 

Appendix A: Unpacking and Initial Setup ...................................................................................... 57 

Tools .......................................................................................................................................... 57 

Components and Fasteners ....................................................................................................... 57 

Appendix B: Load Cell Installation ................................................................................................. 64 

Appendix C: Software Installation.................................................................................................. 66 

Appendix D: Test Setup ................................................................................................................. 72 

Choosing and installing a Riser for the Bottom Grip, Platen, or 3 Point Bend Block ................. 72 

Tension Test Setup ................................................................................................................ 74 

Compression Test Setup ........................................................................................................ 79 

3-Point Bend Test Setup ........................................................................................................ 82 



 

 

 

Appendix E: Camera Setup ........................................................................................................... 86 

Webcam ..................................................................................................................................... 86 

Scientific Camera ....................................................................................................................... 88 

Appendix F: Changing Grip Springs .............................................................................................. 91 



UniVert User Manual 

1 

 

1. General Information 

The UniVert is a precision test instrument designed for the compressive and tensile testing and 
analysis of materials including metals, polymers, and biological specimens. The system includes 
a test station and an integrated software interface to run and analyze test results. 

Environmental and Electrical Specifications 

Electrical Input 100-240VAC, 50-60Hz 

Current Rating 1.67 Amp 

Environmental Conditions Maximum Operating Temperature 25ºC 

0% - 95% Relative Humidity 

Installation Category Category II 

Pollution Degree Degree 2 

Data Connections 1 – USB 2.0 for camera/PC communication 

1 – USB 2.0 for controller/PC communication 

System Assembly 

Some basic assembly and setup is required. An unboxing and setup guide can be found in 
Appendix A.  Load cell installation is detailed in Appendix B and software installation is 
described in Appendix C. Camera setup is described in Appendix E. 

Connections to Supply 

Connect power supply into properly grounded 100-240VAC power source to ensure safe 
operation. Ensure that the power cord is easily accessible at all times. The use of an 
Uninterruptible Power Supply (UPS) is recommended to protect against data loss. 

The mains supply voltage fluctuations should not exceed 10% of the nominal supply voltage. 
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Safety Warnings 

This equipment must be used in accordance with the procedures outlined in this manual. 
Operators of this equipment must be instructed in safe operating procedures to prevent injury 
and/or damage. 

 
Ensure that the area around the moving actuator is clear before commencing test protocols. 

 

 

 

The UniVert presents pinch hazard to extremities. Keep hands clear of moving parts for the 
duration of the test. 

 

System Alert 

This equipment must not be disassembled by the user or modified in any way. 

 

Manual Operating Controls 

There is a single power switch on the front of the control unit to turn on the UniVert. 

General Maintenance 

Clean the system as needed with mild soap and water or alcohol based cleaning solutions.  

Approvals and Certification 

This product conforms to applicable CE standards. 
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2. Testing Terminology 

The UniVert is designed to apply uniaxial compressive and tensile forces to a variety of materials. 
This includes metals, plastics, and composites as well as biological materials. 

Multiphase Test Cycles 

In order to properly characterize and test a specimen, it is often necessary to load it to different 
degrees and at different rates. There are three main reasons for doing this: 

Preconditioning–Especially for biological specimens, the goal of preconditioning is to 
restore a specimen to its physiological or in vivo state. During the process of specimen 
storage and preparation, a specimen may swell, dry out, have its material fibers realign, or its 
molecules reorganize. It may take multiple preconditioning cycles for a specimen to be 
restored to its natural state. 

Reproducing Physiological Conditions During Testing - By applying various loads and 
load rates, natural expansion and contraction of a specimen can be reproduced (for example, 
the pulse pressure in an organ). In as much as the physiological conditions can be recreated, 
the specimen can be tested in a more realistic state. 

Varying Test Conditions - Variable loads and rates allow you to create a variety of test 
profiles to best study your specimen. 

 

  



UniVert User Manual 

4 

 

Phases, Cycles, and Test Sequences 

As the following diagram demonstrates, each application and release of load on the specimen is 
called a test cycle. The same test cycle can be repeated multiple times to achieve a certain goal 
(preconditioning, physiological conditioning, or testing); this is called a test set. Finally, a test 
sequence is made up of multiple test sets.  

 

The above example describes the following: 

 The entire diagram presents a full test sequence.  

 Within that sequence, there are two test sets: the first set applies preconditioning to the 
specimen; the second set executes the actual test on the specimen.  

 Within the first set (preconditioning), two identical test cycles are implemented to bring 
the sample to a satisfactorily preconditioned state.  

 Finally, the second set (testing) is made up of three cycles.  
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Test Phases: The Smallest Unit of Testing 

The test phase is the smallest unit of the test specification. There are five phases within a cycle. 
Each phase serves a specific purpose: 

Preloading- Preloads are applied to bring a test 
to a well-defined starting point. Because the 
dimensions of a specimen may change as a 
result of a loading cycle (stretching of fibers, 
viscoelastic effects, plastic deformation, or 
localized material failure at the attachment 
points), the preload adjustment compensates for 
any of these changes in specimen geometry.  

Stretching - During the stretch phase, a 
deformation is applied to the specimen. The 
deformation can be specified either in terms of 
force applied or displacement achieved.  

Holding - The deformation can be held for a given duration. The duration for which it is 
held is dependent on the nature of the testing. 

Recovering - The recovery phase is the time during which the force being applied to 
the specimen is removed. The duration of the recovery time is configurable and 
dependent on the nature of the testing. 

Resting - Finally, the rest phase is the time between the end of one cycle and the 
beginning of the next. Some tests may specify a short recover time, while others may 
specify a longer time. The duration is configurable and dependent on the nature of the 
testing. 

Control Modes 

There are two control modes which define the basic approach to a given test: displacement 
control and force control: 

Under displacement control, the displacement of the specimen is predefined. The 
UniVert stretches or compresses the specimen until the predefined displacement is 
achieved. The force required to achieve the displacement is an output of the test. 

Under force control, the force applied to the specimen is predefined. The UniVert 
stretches or compresses the specimen until the predefined force is achieved.  The 
displacement required to achieve the force is an output of the test. 

Control Functions 

The UniVert makes it possible to test specimens under several control functions: 

Under displacement control: 

The true strain function applies the displacement at a true strain rate, which accounts 
for the current specimen length while the specimen is being stretched.  The UniVert 
system approximates this with a series of linear segments (default = 10). 

The ramp function applies the displacement at a constant nominal rate. This is 
equivalent to engineering strain or constant velocity.  

The sine function applies the displacement according to a sinusoid with the desired 
displacement magnitude and duration.  The UniVert system approximates this with a 
series of linear segments. 
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Under force control: 

The step function achieves and maintains the desired force as quickly as possible. The 
amount of time it takes to achieve the desired force depends on the material being tested 
and the force control settings.   

 

       Step 
 
 

Time 

Force 

 

Test Modes 

There are three test modes that can be used when performing a test: tension, compression, and 
3-point bending. 

Tensile Test - This test mode is used in combination with provided specimen grips. In this mode, 
positive displacement is in the direction of increased fixture separation and tension forces are 
positive. 

Compression Test - This test mode is used in combination with provided compression platens. 
In this mode, positive displacement is in the direction of decreased fixture separation and 
compressive forces are positive. 

3-point Bend Test - This test mode uses the same displacement and force convention as 
compression testing but is applied to a 3-point bend setup. 
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3. Software Overview 

The software included with the UniVert device is called UniVert.  It is divided into two modules, a 
data collection module and a review and analysis module.  The data collection module is used to 
set test parameters, enable specimen loading and testing, and monitor test progress.  The screen 
layout for this module is shown below: 

 

 

Test 
Parameters 

 

 

 

 

 

 

Live Force & 
Displacement 

 

 

    Live Video    Live Charting 

The review and analysis module is used to playback accelerated or decelerated test images, 
perform image analysis and tracking, and output movie files for presentation purposes.  The 
screen layout for this module is shown below: 

 

 

Image List 

 

 

 

 

Image 
Playback 

 

Image 
Tracking 

 

Data 
Overlay 
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Output Files and Data Structures 

For each test, the UniVert creates and saves three file types. The following table describes the 
three file types for a project named “Sample1”. Output from this test would be found in a 
“Sample1” output directory (a sub directory of the user specified data directory). 

File Type Description 

.tst file The Sample1.tst file that contains the exact protocol and settings used for the test. 

.csv file The Sample1Data.csv file that contains comma separated numerical data such as time, force and 
displacement values. 

.jpg files Captured images such as Sample1.000010.3.jpg, which would correspond to an image captured 
at 10.3 seconds from the start of the test. 

 

Each test folder will also contain 2 subfolders.  The “Logs” subfolder contains a text file of the 
content of the text dialogue portion of the main screen.  It is useful as reference to troubleshoot 
problems with your system, should they occur. 

The “Tracking” subfolder is initially empty.  If tracking is done on any of the images in the test 
folder using the “Analyze and Review” software module, there will be data files that contain the 
tracking information stored in this directory.   

While using the “Analyze and Review” software module, you may create additional data files such 
as text files (*.csv) containing tracking results, images with force data or tracking results overlaid 
(*.wmf), or movie files (*.avi).  These additional files can be stored in the test directory or 
elsewhere on your computer’s hard drive without interfering with the software application (once 
created, they cannot be opened by the UniVert application). 

When working with the data, you should be aware of a few details regarding the data output: 

1. The output specimen size is based on the spacing between the grips or platens and does 
not account for the specimen material outside of the test region. 

2. The software cannot calculate stress since the thickness of the specimen is not known. 
To calculate stress, you will have to manually measure the thickness of the material 
before or after the test is performed. 

3. Strains can be calculated using the output displacement values (which are based on the 
grip or platen motions). The specimen may actually be subjected to less strain than the 
calculated values due to attachment site effects. The image tracking module is useful for 
determining the actual strain values and variations within the specimen. 
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4. Setting Up & Starting a Test 

Overview 

Setting up and running a new test is a simple process made up of both mandatory and optional 
steps. The following list presents all of the steps, while the rest of this chapter describes each of 
the steps in detail. 

Step 1: Start a New Test 

Step 2: Reset the Actuator 

Step 3: Specify Test Type 

Step 4: Move the Actuator to a Specified Size 

Step 5: Zero the Load Cell (occasional) 

Step 6: Modify the Test Parameters (optional) 

Step 7: Mount the Specimen 

Step 8: Execute the Test 

Step 9: Terminate the Test Prematurely (optional) 

Step 1: Start a New Test 

Launch the UniVert software and then select Collect New from the File menu.  

 

 

 

In the Create Test From Template dialog, perform the following steps: 

1. Select a template that matches the type of test you wish to perform. See the UniVert Tip 
on how to select and use a template. You can modify the template parameters in Step 4, 
below.  

2. Name your test. The dialog will have a default test name. You can use the default or 
rename the test. Each time you start a new test, the default name will continue to 
increment the number at the end of the name. 
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3. If desired, you can change the location of the output data. The location of your output 
data and images is determined by specifying a Test Name and Data Directory. The 
template and data directories are user specific (computer login name). Each system user 
can store their files to a different default location. The system uses the last location 
selected as the default. 

 

UniVert Tip: Selecting and Using Templates 

How to select a template: Designing an appropriate test sequence is an art that 
depends on both the type of material being tested and the specific material properties 
you are interested in measuring. When first testing a new material, you should expect to 
have to experiment with the settings until the test yields meaningful data.  

The system comes loaded with example templates to help you get started. Selecting a 
template does not lock you into a specific test sequence or protocol – rather a template 
defines a test sequence and settings, all of which can be changed before a test is run. 
Once you have developed a test sequence and settings that are appropriate for the 
material you are testing, you should save these settings using “Save As Template” from 
the File menu. You can then select your template the next time you initiate a test. 

Step 2: Reset the Actuator  

We suggest performing a reset at the start of a new test session. This command sends the 
actuator to its fully retracted position and resets the displacement value.  If you have stopped the 
previous test in mid cycle, then you should also reset the actuator. By resetting the actuator, you 
are ensuring that the physical measurements taken by the UniVert are accurate. 

To reset the actuator, select Reset Actuator from the Tools menu, or press  on the toolbar. 

 

System Alert 

You should NOT reset the actuator if the specimen is already loaded in tension. Doing 
so will damage your specimen and/or the load cell. 
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Step 3: Specify Test Type 

Access Test Mode in the Settings menu to select the appropriate test mode and install the 
platens, grips, or 3-point bend attachments (see Appendix D for this procedure). 
 
 

 
 

 

Step 4: Move the Actuator to a Specified Size 

After the actuator has been reset, it will remain in the fully retracted position and must be moved 
to a specified (reference or starting) position.  

To move the actuator to the specified position, select Move Actuator to Specified Size from the 

Tools menu, or press  on the toolbar.  This size may be entered in the “Specified Size” 
dialogue. 

  



UniVert User Manual 

12 

 

Step 5: Zero the Load Cell (occasionally) 

While it is not necessary to zero the load cell with every test sequence, we suggest zeroing the 
load cell at the start of a new test session. With repeated use, the zero point of the load cell can 
drift. By zeroing the load cell, you are ensuring that the force measurements are accurate. 

To zero the load cell, select Zero Load Cell from the Tools menu or press  on the toolbar. 

 

System Alert 

You should zero the load cell after attaching a platen or grip but before mounting a 
sample. If a specimen is already loaded when the load cell is zeroed, the force reading 
will include an offset load. 

 

 

Step 6: Modify Testing Parameters (optional) 

You can select and modify the parameters in the test 
sets by clicking on a row in the Test Sequence table 
and then pressing the Edit Set button (or by double 
clicking on the desired row). When you do so, the Set 
Parameter Editor dialog will appear.  

Note that displacements are specified in either % 
strain, or mm. Force loads are specified in N, and 
durations are specified in seconds. 

The following table describes each of the parameters. 
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Test Parameter Description 

Control Mode Tests are typically performed under displacement control, however, you can select the 
following control modes to achieve specific testing objectives: 

 For creep testing, use force control with a long hold duration. 

 For stress relaxation testing, use displacement control with a long hold 
duration. 

Control Function True Strain or Ramp is typically selected for tests performed in displacement control 
mode. For tests performed in force control mode, Step controls are selected.  

Stretch Magnitude  
(Load Magnitude when in 
Force Control mode) 

Selecting a stretch magnitude is dependent on the material you are testing. A sound 
approach is to begin with a small magnitude and iteratively move up to larger 
magnitudes.  

If you are using Displacement control mode, you can specify the displacement in either 
mm or as a percentage. For example, the displacement on a 5mm specimen can be 
expressed as either 0.5mm or 10%. 

If you are using Force control mode, you can only specify the force in N. 

Watch the test results carefully to determine which magnitude setting best achieves 
your test goals. 

Preload Preload is typically reapplied on every repetition during a preconditioning set as well as 
on the first repetition of a testing set. Specimen size is adjusted after a preload 
adjustment. Strain calculations are based on the specimen size after the last preload 
adjustment.  If you are working with a material for which preload values have been 
suggested, you can set the value accordingly. Otherwise, zero is a good initial choice. 

Preload Magnitude As with stretch magnitude, the preload magnitude settings depend on the material you 
are testing. While Preload can be set at zero, typically you would set the preload 
magnitude somewhere between zero and 10% of the peak load you expect to achieve. 

Stretch Duration For evenly spaced images, it is recommended to choose a number that is an integer 
multiple of the Image Output Frequency. 

Hold Duration Hold Duration is typically set to 0, however it is useful for creep or relaxation testing. 

Recovery Duration Recovery Duration is typically set to the same value as the Stretch Duration. 

Rest Duration Rest duration is typically set to 0, however a non-zero value may be used to mimic in 
vivo conditions or for specialized testing. 

Repetitions Apply enough repetitions until the force deformation curves from one repetition to the 
next start to overlie each other. 

Data Output Frequency Typically set to the same frequency as the image output frequency. 

Image Output Frequency Typically set to 1Hz for cycles > 5 seconds and 15 Hz for cycles < 5 seconds. 

 

UniVert Tip: Idle Current 

Idle current (holding current) can be applied to the motors.  The motors have a holding 
force in the de-energized state of approximately 100N.  If forces in excess of 100N are 
expected it is recommended that idle current is used to prevent position loss during 
velocity and direction changes when the motors are de-energized for a very short time.  
When idle current is activated the motors will produce more noise, even when the 
actuator is at rest.  This setting may be accessed by selecting Hardware from the 
Settings menu. 
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Step 7: Mounting a Specimen 

Platen Mounted Specimens 

1. Select an appropriate riser to accommodate the size of the specimen (see Appendix D). 
2. Place the specimen on the bottom platen.  
3. Jog the top platen to the correct position using the jog arrows in Actuator Control 

 

 

Alternately, the Move Actuator to Specified Size  command may be used. 
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UniVert Tip: Compression Specimen Mounting 

Make sure to center the specimen on the platen as much as possible to ensure 
accuracy in the force reading. Ideally, specimens will have two parallel flat sides and will 
make full contact with both platens. Although this is not always possible, flat testing 
surfaces will improve force distribution. 
 

 

Grip Mounted Specimens: 

Low Force Grips 

1. Select an appropriate riser to accommodate the size of the specimen (See Appendix D). 
2. Select a grip with appropriate clamping force for the specimen being tested (see Appendix 

E for more details). 

3. Jog the actuator using Actuator Control or select Move to Specified Size  until the grips 
are sufficiently far apart and attach the specimen to the top grip. 

4. Using Actuator Control, lower the top grip (with specimen attached). 

5. Open the bottom grip and lower the specimen between the grip surfaces.  Release the 
bottom grip. 
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High Force Grips 

1. Select an appropriate riser to accommodate the size of the specimen (See Appendix 
D). 

2. Select a grip with appropriate clamping force for the specimen being tested (see 
Appendix E for more details). 

3. Jog the actuator using Actuator Control or select Move to Specified Size  until the 
grips are sufficiently far apart and attach the specimen to the top grip using the 9/64 
hex key provided. 

 

4. Using Actuator Control, lower the top grip (with specimen attached). 

5. Open the bottom grip and lower the specimen between the grip surfaces. Grip the 
specimen by tightening the grip using the 9/64 hex key again. 
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3-point Bend Specimens 

1. Use the 80mm riser to ensure the sample is in the range of the actuator (see Appendix 
D) 

2. Choose an appropriate sized 3-Point Bend dowel for the type of test you wish to perform. 
3. Install the 3-Point Bending test setup (See Appendix D) 
4. Move the sliders into desired position and lock in place by tightening the M3 fastener to 

the rail. 
5. Place the specimen on top of both lower dowels and begin testing. 
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Step 8: Execute the Test 

Select Execute from the File menu, or press the  button on the toolbar. 

Step 9: Terminate the Test Prematurely (optional) 

You can stop a test at any time by clicking  on the toolbar, or by selecting Stop from the File 
menu. This is preferred over powering down the equipment, as it allows the software to store the 
current actuator position.  

At the end of the completed test (both normally or prematurely terminated) the actuators will 
maintain their current position.  

 

 

 

System Alert: Load Cell Handling 

It is important to handle load cells carefully. Here are some things to consider while 
handling a load cell: 

 The load cells are designed to handle overloads of up to 120% full scale value. 
Overloading a load cell past this rating may cause permanent damage to the 
load cell 

 Avoid applying excessive torque and transverse forces to the load cells. Over 
tightening grips or platens onto the active end of the load cell may damage it. 

 Accidently crashing the platens or grips together will produce more force than 
most load cells can handle. Be careful and reduce actuator speed when jogging 
grips or platens close together. 

 Generally avoid dropping, tapping, and exerting unnecessary force to increase 
the life the load cell. 

 

 

 

  

UniVert Tip: Specimen Thickness 

Measuring the specimen thickness before and/or after a test is performed will allow 
stress calculations to be made from your output data. 
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5.  Additional Settings 

Configuring Output Data Files 

From the Settings menu, select Data Output to display the dialogue shown on the left. Click the 
Configure button to select which of the following columns to output. 

 

 

 

 

Output Column Description 

Set Name  User defined name of each set 

Cycle Cycle and Phase information 

Time (S) Time in seconds 

Size (mm) Specimen Gage Length 

Force (N) Load Cell reading 

Displacement (mm) Reports the change in size relative to the initial size 

Compensation (mm) Reports overall compensation due to system stiffness (see Section 8). Off by default. 

  



UniVert User Manual 

21 

 

Advanced System Settings Dialogue 

Advanced settings are available by selecting Advanced from the Settings menu.  All of these 
settings are specific to the test template selected. 

True Strain Rate 

Unlike nominal or engineering strain 
rate, a plot of velocity versus time for a 
true strain rate test would be non-linear. 
The degree of non-linearity increases 
with increasing strain. The UniVert 
approximates this non-linear curve with 
a series of linear segments. Typically, 
10 line segments is a sufficiently close 
approximation. More segments can be 
used, but you should bear in mind that 
the actuator velocity can only be 
updated every 250ms. 

Data Averaging 

The load cells are sampled at 100Hz 
with hardware using a central moving 
average of 8 samples. Further data 
averaging can be applied to smooth 
noisy data. 

Force Control Settings 

Force Control Settings affect the rate 
and stability at which forces are 
achieved in force controlled procedures.  
These settings apply to preloads as well 
as Force Control Modes. 

 

Kx (Default = 100, integer values) is a proportional gain tuning parameter.  It controls the 
sensitivity or the amount of corrective action that is applied to the difference between the 
current and target force values. At low gain values the system may be safe and stable but 
may be sluggish in response to changing conditions.  If the proportional gain is increased the 
system becomes more responsive and loads are achieved more quickly.  If Kx is set too high, 
an unstable oscillating system may result and forces may never be achieved. The optimal 
value for these settings depends on the properties of the material being testing.   For stiff 
materials, values may range between 10 and 50.  For soft materials, values may range 
between 50 and 500. 

Tolerance (N) (Default = 0.1) controls how close to the specified force the actual load values 
need to be. For example, a specified force of 10N with a Tolerance of 0.1 N will be 
considered achieved when the loads are between 9.9 and 10.1 N.  Keep in mind the 
accuracy of the load cell being used when choosing the value for this parameter.  The load 
cells typically fluctuate by about 0.1% of their full scale during the course of a test.  For a 10N 
load cell this is about 0.01N but for a 200N load cell, this is about 0.2N.  This value should 
usually be 0.2-0.5% of full scale to ensure stable operation. 

Settling Frames (Default = 5) controls how many successive load samples (sampled at 100 
Hz) need to be within the Tolerance criteria for the force to be considered achieved. For 
example, a specified force of 10N with a Tolerance of 0.1 N and Settling Frames = 5 will be 
considered achieved when the loads are between 9.9 and 10.1 N for 5 successive data 
samples at 100Hz. 
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Velocity (1-10 integer values) matches actuator jog speed.  Typically for stiffer materials, this 
value should be between 6 and 8 and for soft materials, this value should be between 8 and 
10. 

Acceleration (1-10 integer values). Typically this should be set to the default value of 10 
(maximum acceleration).  Changes made to the acceleration will affect tests under both force 
and displacement control.  Reducing this value may help smooth force controlled tests under 
low loads or displacement controlled tests at high speeds.  Tests run with lower accelerations 
will have softer transitions at direction or speed changes but may take longer than specified 
to achieve testing cycles. 

 

UniVert Tip: Testing Force Control Settings 

It is important to have appropriate Force Control Settings that match the materials you 
are testing.   

To safely test Force Control Settings:  press  
on the tool bar, or from the Tools menu select 
Move Actuators to Specified Load.  The dialogue 
shown on the right will appear.  The UniVert will 
attempt to achieve the specified load (force) but 
will stop when the specified load is reached, the 
actuator has displaced by the maximum 
specified amount, or the timeout time has 
elapsed. 

If the actuator oscillates around the specified 
loads but never achieves them try reducing Kx 
and/or decreasing the velocity. 

 

If the actuator reaches the specified load too 
slowly, try increasing Kx and/or increasing the 
velocity. 

 

 

 

Reset Actuators 

Resetting the actuators with a sample attached may damage the specimen, BioRakes, and/or 
load cells.  To avoid resetting the actuators with a sample attached, a warning dialogue will 
appear after “Reset Actuators” is selected, prompting the user to proceed.  This feature can 
be disabled by de-selecting “Show Warning Before Resetting Actuators”. 
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Range Limits 

Range limits can be accessed by selecting Range Limits from the Settings menu.   

Soft Limits 

To avoid collisions or sample 
destruction, it is useful to assign 
reasonable travel limits to the 
actuators. This is especially 
important during force control or 
preloading, where if specified loads 
cannot be reached, the actuators 
will keep moving until they reach the 
soft limits. 

Min and Max Displacement, in 
mm, set the minimum and maximum 
positions to which the grips or 
platens are allowed to move.  These 
settings require adjustment 
especially when the riser is 
changed. 

Max Force, in N, sets the maximum 
value of force at which a test will be 
automatically stopped.  The default 
value is set to the capacity of the 
load cells.  Setting this value may be 
useful to prevent sample destruction 
or overloading of the load cells. 
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Configuring the Live Charting Graphs 

The three graphs on the right side of the 
screen provide real-time user feedback during 
a test. These graphs are intended to be used 
for qualitative feedback, not for detailed 
analysis.  

The graphs are updated at a maximum 
frequency of 10Hz; certain short-duration tests 
may not show all the detail that is actually 
present.  

The graph settings can be specified by 
selecting Graphs from the Settings menu. Auto 
scaling allows the axis min and max to start at 
the specified values but expand if the data 
values are larger or smaller than the initial 
limits. 
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Graph Data 

Force versus Time 

This graph shows how the measured forces are 
changing with time. Peak loads per cycle and force 
relaxation are all easily seen in this type of graph. 
Force is proportional to nominal (engineering) stress. 

 

Displacement versus Time 

This graph shows how the grips or platens are moving 
with time. The phases of the test sequence and size 
adjustments due to preloading are readily apparent in 
this type of graph. 

 

Force versus Displacement 

This graph displays a qualitative representation of the 
material behavior. Viscoelastic effects (like hysteresis) 
and material response to different loading phases are 
apparent in this graph. This graph is proportional to a 
nominal (engineering) stress-strain graph. 
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6. Reviewing Test Results 

Overview 

The UniVert software has an integrated image analysis module which can be accessed by 
selecting Analyze and Review Images from the File menu, then selecting the appropriate test file.  
The test file is a text file with a .tst extension that contains information about the test parameters 
so that the software can display the images and data in a useful fashion. 

 

 

 

Image List 

 

 

 

 

 

Image 
Playback 

 

 

Image 
Tracking 

 

 

 

Data 
Overlay 

 

 

 

The basic UniVert system comes with a Logitech HD 1080p webcam intended to be used for 
recording images for image playback and review. This camera and software associated with it 
does not support image tracking. 

For image tracking to be available, the advanced scientific monochrome camera must be 
purchased. 
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Selecting Images 

The Images are shown in a tree structure on the top left panel. 
The tree structure organizes the images by: 

Set (line on the test parameter window) 

Cycle (iteration of a given Set) 

Phase (Preload/Stretch/Hold/Recovery/Rest phase of each 
Cycle) 

Image (the one or more individual images from each Phase) 

You can select which images to include in a playback set in 
one of several ways: 

 Hold down the shift key and click on individual images 

 Select entire sets, cycles, or phases (will playback all 
contained images) 

 Select images which have data associated with a 
particular tracking set 

 

Image Playback Options 

The controls on the left of the screen are broken into 2 sections: 
Playback and Tracking. The playback buttons allow the user to review 
the images taken during a test. 

 

Next/Prev Display next or previous image (as dictated by “Play Every” parameter). 

Play/Stop Start and stop the playback. 

Prev/Next Cycle Jumps to a corresponding image and phase in the next or previous cycle. Useful when reviewing 
sets that have multiple cycles. 

Loop Sequences can be played continuously in a loop or only once. 

Playback Rate +/- changes the speed of the playback. A playback rate can also be manually entered in the 
display box. 

Play Every Allows the user to skip some frames to expedite playback. 
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Image Tracking: Overview 

Image tracking is a function that can be used to quantify the 
motions of image features (specimen texture and fiducial 
markers). This can be useful for studying localized specimen 
deformations, verifying strain magnitudes, and comparing the 
results of one test to another.  

The image tracking engine is based on a template matching 
algorithm. This algorithm starts by defining a “patch” of pixels 
(called a template) surrounding the selected source point on the 
source image. It then determines the optimal location for this 
template on a target image within a specified search region.   

The algorithm defines the location of the tracked point on the target image as the center of the 
optimally located template.  

To track an image, follow these steps: 

1. Click the Create button in the 
tracking window, shown 
above. This brings up the 
Tracking Editor dialogue box. 

 

2. Enter a Tracking Name. 

3. Select Source Image in the 
test image list tree, and click 
Set to the left of the Source 
box. 

4. Select the Target Images in 
the test image list tree, and 
click Set to the left of the 
Target box. The target image 
list will automatically be sorted 
to remove duplicates and be 
put in sequential order. 

5. Generate source points on the 
source image by performing 
the following steps: 

a. Manually click source point 
locations on the source 
image 

 with the Add button depressed. 

b. Draw a box on the source image with the Select button depressed, then click the Grid 
button and define a grid of points. 

The displayed image will automatically change to the source image when either the Add 
or Grid buttons are depressed. 



UniVert User Manual 

29 
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6. Modify search parameters: 

Source 
Template 

The optimal source template is difficult to predict, but in general it is 
advantageous for the template to be large enough that it contains at 
least one feature, but not so large that it contains multiple features.  
Typical values for this parameter are between 15 and 55, with 35 
being a good starting point for most users. 

Search Region The search region needs to be large enough that the optimal 
location for the template is found. In general, no part of the 
specimen moves more than the grips or platens, so the motion of 
these is a good guideline for how large the template needs to be.  
For example, if they move 50 pixels over the 10 frames you are 
interested in, it is unlikely that any part of the specimen is moving 
more than 5 pixels/frame and so a good value for the search region 
parameter would be 11 (5 pixels each way, plus the center pixel). 

Use Source 
Template From 

First Image tracks all images against the first in the series (1→2, 
1→3, 1→4…). 

Previous Image tracks each subsequent image against the image 
before it (1→2, 2→3, 3→4…). 

First Image Tracking tends to have poorer correlation than Previous 
Image Tracking because the current image is usually closer in 
content to the previous image than it is to the first image in the 
sequence. Previous Image Tracking tends to have good correlation 
for each individual step, but is prone to error accumulation since 
each step is independent. The best method for a given data set will 
depend on the number of images and the content of the images.  
Sometimes it is best to use Previous Image Tracking but to only 
use every other image or every nth image rather than all the images 
available. Sometimes it is best to use First Image Tracking and use 
every image but set the source image in the middle of the image 
series rather than at the beginning.   

Set Search 
Region Centre 

New Point Locations The location of the center of the search 
region is set to the same location of that point in the previous image 
(even when the source template is from the first image). 

Existing Point Locations The search region center location is set 
to the previously tracked location of that point. When no previously 
tracked point exists, the location is chosen in the same way as New 
Point Locations.  

Use Strain 
Based 
Deformable 
Templates 

When this option is checked, the source template will be scaled 
according to strains calculated from the Size parameters from the 
test data. In other words, the source template will be deformed 
according to the displacement of the grips or platens at that point in 
the test.  Best tracking results are often obtained when using this 
option. However, this option may not be the best for simple uniaxial 
tests or tests where the specimen deformation is non-uniform. 

7. Perform tracking with either Track All Points or Track Selected Points. 
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Image Tracking: The Points Display Option 

The Points option displays the points in their current 
location (i.e. their location on the currently displayed 
image) with or without gridline connecting points 
that were generated using the grid function.  

Clicking the Details icon brings up the window 
shown to the right. Options include changing the 
point radius or color, showing ID numbers and 
showing gridlines with or without ID numbers.  

Gridline ID numbers are associated with each grid 
square (cell), while Point ID numbers are associated 
with the points themselves. 

Tracking display settings default to the last used 
settings. 

 

 

 

 

 

 

Figure 1: Initial tracking grid displayed as 
points. 

 

Figure 2: Tracking to 33% strain displayed as 
points. 

 



UniVert User Manual 

32 

 

Image Tracking: The Displacement Option 

The Displacement Option displays the points in their 
current location as well as graphically representing their 
motion through time.  

Clicking the Details icon brings up the window shown to 
the right. This dialogue allows the user to change the 
reference image, change the type of connecting line, 
and change the line appearance.  

Displacement connecting lines directly connect the 
reference and current points via a vector or a path. The 
path option provides more information but can result in 
slow playback speeds for sets with many points and/or 
many images.  

The Flow option generates a direction vector based at 
the current location and oriented in the direction of 
motion relative to the reference image. This can be 
useful because the length of this vector can be scaled 
to better visualize small displacements. 

Tracking displacement settings default to the last used 
settings. 

 

 

 

 

Figure 3: Tracking to 33% strain displayed as displacement. 
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Image Tracking: The Strains Option 

The Strains Option can only be used in conjunction with a grid 
of points (as opposed to individually placed points). This option 
calculates the regional strains inside every grid box and 
displays this data as an ellipse. One can imagine this is what 
would happen to a grid of circles drawn on the surface of the 
specimen at the beginning of the test. 

Clicking the details icon brings up the window shown to the 
right. This dialogue allows the user to change the reference 
image as well as the appearance of the circles and text.  

Showing text for E1, E2 will result in the text showing the 
strains along the major and minor axis of the ellipse. Showing 
text for Ex, Ey will result in text showing the strains along the X 
and Y directions regardless of the ellipse orientation. 

A 4-point or 16-point average can be used to calculate the 
strain inside each grid box (each individual grid box or each 
box plus additional surrounding grid points).  

Tracking strain settings default to the last used settings. 

 

 

 

 

 

Figure 4: Tracking to 33% strain displayed as strain ellipses 
with text showing x% strain. 
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Data Overlay 

Data associated with each image is displayed below 
the tracking controls on the left side of the main 
window.  Checking the Show Graph box displays this 
data as a graph overlaid on the images 

 

 

Clicking the details icon displays the window shown to 
the right. The dialogue allows the user to change the 
size and appearance of the overlaid graph. The data 
points associated with the current image are marked on 
the graph with green circles. The overlaid data graph 
will be drawn on top of any image tracking displays 
(when they overlap). 

Data Overlay settings default to the last used settings. 

 

 

 

 

 

 

Figure 5: Tracking to 33% strain with overlaid force graph. 
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Exporting Tracked Data 

Tracked grid point coordinates and calculated grid 
strains can be exported to a .csv file. From the Export 
menu, select Data Points to display the dialogue shown 
on the right. The image list is automatically set to the 
currently selected images in the test image list tree.  
This image list can be changed by selecting new 
images in the test image list tree and pressing the set 
button. When exporting strains data from Selected 
Tracking Points, all four points of a grid cell need to be 
selected for data from that cell to be exported. 

Exported data is labeled with associated ID numbers 
(grid point ID numbers for exported coordinates and 
grid cell ID numbers for exported strain values).  To 
display ID numbers on tracking grids, see Image 
Tracking: The Points Display Option.  In the following 
example (Figure 6), grid point ID numbers are shown in 
yellow and grid cell ID numbers are shown in white.  

 

  

 

Figure 6: Tracking Grid showing ID Numbers. 

 

Figure 7: Sample Exported Data. 
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Exporting Images and Movies 

The current Image view, including all displayed tracking 
grids, tracking data and overlaid data can be exported 
as a metafile by selecting Current Image from the 
Export menu.  Alternately, the current image view can 
be copied to the clipboard by pressing Ctrl-C on the 
keyboard. 

To export a series of image views, including all 
displayed tracking grids, tracking data and overlaid 
data as an .avi movie, select Movie from the Export 
menu.  The dialogue shown on the right will be 
displayed.  The image list is automatically set to the 
currently selected images in the test image list tree.  
This image list can be changed by selecting new 
images in the test image list tree and pressing the Set 
button.   Options are available for setting the frame rate 
or image size (resolution), adding filenames, and 
choosing color or grayscale output.  File compression 
options are also available. 
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7.  System Hardware Settings 

Controller 

The UniVert uses an integrated control board rather 
than a group of PC controlled device drivers. This 
minimizes communication lag and allows the device to 
operate asynchronously with the PC. The control board 
details can be seen by selecting Hardware from the 
Settings menu, which brings up the window shown to 
the right. 

 

 

 

Camera 

The UniVert software can be equipped with the standard webcam package, the scientific camera 
package, or no camera at all. The software will automatically detect which camera configuration is 
in use. 

Webcam Package 

The basic UniVert system comes with a Logitech HD 
1080p webcam intended to be used for recording 
images for image playback and review. This camera 
and software associated with it does not support 
image tracking. 

For image review purposes the webcam will capture 
images at up to 5 frames per second and obtain a 
resolution of 1900 pixels by 1080 pixels. Images 
captured by the webcam are written to a buffer. The 
test controller extracts images from this buffer at the 
specified frequency specified in the Set Parameter 
Editor (5Hz, 1Hz, 0.1Hz, 0.01Hz, or 0.001 Hz) These 
images are written to the output directory. The file 
name is the ideal capture time. The actual capture 
time may differ from the ideal capture time by as much 
as 1/30 of a second since the images are extracted 
from a buffer.  

 

 

The test software creates an image capture log file in the output directory should this difference 
be significant. This log stores the actual capture time and the idealized capture time. 

The webcam can be focused using the focus control in the Camera tab under Hardware in the 
Settings menu. The focal distance is set by entering a value between 0-100 (The higher the 
value, the smaller the focal distance). 

The shutter and gain control on the webcam are controlled automatically.  
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Scientific Camera Package 

The advanced scientific camera package is not included with the base UniVert system and is 
available as an added feature. This advanced option provides high quality monochrome images 
suitable for image tracking and the associated software is enabled with the image tracking 
feature (See Section 6: Image Tracking). 

The camera uses a ½” monochrome CCD sensor to obtain a resolution of 1280 pixels by 960 
pixels. The camera shutter and gain can be controlled by accessing the Camera tab in 
Hardware Settings. 

The scientific camera captures images at 15 frames per second during every test and writes 
these images to a buffer. The test controller extracts images from this buffer at the frequency 
specified in the Set Parameter Editor (15Hz, 5Hz, 1Hz, 0.1Hz, 0.01Hz, or 0.001Hz). These 
images are written to the output directory. The file name is the ideal capture time. The actual 
capture time may differ from the ideal capture time by as much as 1/30 of a second since the 
images are extracted from a buffer. 

The test software creates an image capture log file in the output directory should this difference 
be significant. This log stores the actual capture time and the idealized capture time. 

The camera default shutter and gain are specific to each test template and can be set by 
selecting the Camera tab in Hardware from the Settings menu. The recommended maximum 
shutter speed is 10mS.  Typically, the camera iris is left fully open and the shutter and gain are 
adjusted to achieve the desired image brightness. 

Load Cell 

The load cells are semiconductor strain gage-based. 
They have accuracy equal to 0.2% of the rated full 
scale load. Load cells are available in 10N, 20N, 50N, 
100N, and 200N sizes. Each load cell has a unique 
calibration factor which is stored in a chip contained in 
the load cell connector. 

While the load cells should not have significant 
hysteresis or thermal drift, temperature changes or 
prolonged loading can introduce small offsets. It is 
recommended that the zero load state be redefined 
before beginning a test. This can be done by selecting 
Zero Load Cells from the Tools menu or selecting 

 . 

 

The load cells are sampled at 100Hz, with hardware providing an 8 sample averaging to reduce 
noise in the data. Further sample averaging can be implemented by selecting Advanced from 
the Settings menu. 

Each load cell is calibrated and has a specific calibration factor which is stored on a chip in the 
load cell connector.  Field calibration using weights of known mass is recommended (see 
Section 8 of this manual).  The range and calibration factor can be viewed by selecting 
Hardware from the Settings menu, but are not directly user controlled. 

Warning: Permanent load cell damage can occur if 120% of the full scale value is exceeded. 
Handle the load cell with care and make sure to select appropriate test protocols to avoid 
overloading. 
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Actuator and Motor 

The actuator is driven by a stepper motor under open 
loop control. The motor moves a lead screw-driven 
shaft attached to the load cell and then the platens or 
grips. The actuator has a peak velocity of 20mm/s. To 
prevent excessive velocities and accelerations, the 
control software will issue warnings if entries in the Set 
Parameter Editor result in accelerations or velocities 
that are out of range. Excessive thrust loads should 
only occur if mechanical interference obstructs the 
movement of the actuator. It is advisable to reset the 
actuators occasionally. 

 

Idle current (holding current) can be applied to the motors.  The motors have a holding force in 
the de-energized state of approximately 100N.  If forces in excess of 100N are expected it is 
recommended that idle current is used to prevent position loss during velocity and direction 
changes when the motor is de-energized for a very short time duration.  Turning idle current on 
may produce smoother motions in force control (since the motors are frequently stopping and 
starting). When idle current is activated the motors will produce more noise, even when the 
actuator is at rest. 

 



UniVert User Manual 

40 

 

8. System Calibration and Advanced Tools 

Load Cell Calibration 

The load cells are preset with a calibration factor at the production facility.  However, calibration in 
the field is recommended.  When the load cells are set up for the first time, changed, or moved it 
is advisable to perform a load cell calibration.  The user must obtain a set of calibration weights 
for this purpose. 

This calibration can be performed using the following steps: 

1. Attach the compression platen to the load cell 

2. Reset the actuator  

3. Place the unit upside down on a flat, sturdy surface. 

4. From the Tools menu select Load Cell Calibration 
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5. Zero the load cell to remove the weight of the platen from the calibration values 
measured 

6. Measure the zero load condition for the first calibration point (no calibration weight) 

a. Enter “0” in the Enter Weight dialogue 

b. Click Read 

7. Gently place a test weight onto the platen. This weight should be between 25%-90% of 
the load cell full scale value to ensure accurate calibration. 

Centre the weight on the load-bearing surface to ensure in-line loads and use weights 
corresponding to the load cell capacity range. Do not overload the load cell. 

8. Take a measurement of the calibration test weight. 

c. Enter the weight in grams in the Enter Weight dialogue 

d. Click Read 

9. If desired, repeat steps 7 and 8 for multiple weights covering most of the load cell range.  
However, at least one weight of at least 50% of the load cell range is recommended. 
 

10. Click “Run”. 

11. Check the Relative Calibration Factor and Absolute Calibration Factor for reasonable 
values.  The Relative Calibration Factor is a ratio of the new calibration factor to the 
previous calibration factor.  Ideally, this value should be between 0.99-1.01.  The 
Absolute Calibration Factor is the actual calibration factor in mV/V.  This value should be 
between 25-45.    

12. Click “Apply” 

13. Click “Done” 
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Note: Only take one reading per calibration weight used.  Multiple readings of a single 
load value can cause an error in the calibration algorithm  

Be sure to re-zero the load cell in the upright testing position  
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Alternate Method 

When calibrating load cells with large full scale values (100N, 200N) the calibration weight 
required may not fit inside the UniVert main unit when it is placed upside down. In this case, 
follow these steps: 

1. Carefully remove the load cell being calibrated. 
 

2. Attach the two provided calibration plates to both ends of the load cell. 
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3. Orient the setup such that the measuring end of the load cell is facing up and continue 
with the standard calibration procedure described above. 
 
 

 

 

System Alert: Load Cell Handling 

It is important to handle load cells carefully. Here are some things to consider while 
handling a load cell: 

 The load cells are designed to handle overloads of up to 120% full scale value. 
Overloading a load cell past this rating will cause permanent damage or failure. 

 Avoid applying torque and transverse forces to the load cells. Over tightening 
grips or platens onto the active end of the load cell may damage it. 

 Accidently crashing the platens or grips together will produce more force than 
most load cells can handle. Be careful and reduce speed when jogging grips 
close together. 

 Generally avoid dropping, tapping and exerting unnecessary force to increase 
the life the load cell. 
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Zero Position Calibration 

The actuator position is indicated in the Current Size dialogue on the left-hand side of the screen.  

 

This is the current separation of the edges of the clamps or platens.  In order for this 
measurement to have meaning, a zero position must be defined.  This is a position where the grip 
or platen tips would just touch each other.   

The Move to Size  command is also dependent on a correctly defined zero position. 

An actuator zero position is preset at the production facility before the UniVert unit is shipped.  
However, the zero position should be re-calibrated on initial system setup and whenever the 
grips, platens, load cells, or risers are changed.  Changing these components will always alter the 
zero position by a certain amount. 

There is a software utility to automatically calibrate the zero position using a spring of known 
length provided with the UniVert system. Three different springs are provided with the system to 
accommodate different sized risers.  

The calibration spring is placed between the upper and lower grips or platens.  The calibration 
utility slowly moves the grips or platens together until a small load is detected when contact with 
the spring occurs.  It then assigns this position as the size of the calibration spring being used.  



UniVert User Manual 

46 

 

To calibrate the zero position, follow these steps: 
1. Before starting a center position calibration, choose an appropriate calibration spring 

(provided with the UniVert system). Use the bronze calibration spring with the 80mm 
riser, the red calibration spring with the 40mm riser, and the blue calibration spring 
when no riser is used. 
 

 

 
2. Open the Zero Position Calibration utility by selecting Zero Position Calibration in the 

Tools menu. 
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3. Place the provided calibration spring on the bottom platen or grip. 
 

  

 

 

 

4. Zero the load cell using the Zero Load Cells button 
 

5. Specify the spring length (mm).  This figure is provided for each spring included in the 
UniVert system. 

 

6. Using the jog buttons, move the actuator such that there is a small gap between the 
top of the spring and the bottom of the upper platen or grip.  Do not contact the top of 
the spring.  
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7. Select Run and let the calibration utility proceed. The software will calibrate the zero 

position automatically. 
 

8. Press OK to Reset Actuators and complete the calibration 
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System Stiffness Compensation 

System Stiffness Compensation can be used to compensate for the small displacements that 
occur in the system during testing.  These displacements arise from any strains in the load cell 
and any bending or deformation of the system during loading.  Under most loading conditions 
these displacements are negligible and system stiffness compensation is not required.  System 
stiffness compensation plays a more significant role when testing stiff specimens that achieve 
high loads at low displacements.   

 

System Stiffness Compensation can be enabled or 
disabled under the Advanced Settings dialogue 
(Advanced from the Settings menu).  

 

When enabled, output displacement and size data in 
the .csv data output file will be modified.  For 
example, in a test where a 10 mm specimen is being 
compressed by 1mm at 100N of force the system 
may be displacing by 0.1mm.  In this case when the 
actuators have moved 1 mm the specimen will only 
have been deformed by 0.9 mm and the other 0.1 
mm will have gone into deforming the load cell and 
system.  The output will show a displacement of 0.9 
mm (rather than 1.0) and a specimen size of 9.1 mm 
(rather than 9 mm). 

 

Note: The system stiffness compensation does not 
affect or alter the applied loads or displacements 
only the reported values in the output .csv files. 

 

The amount of compensation being applied to the 
displacement and size columns of the output data 
file can also be shown as an additional output 
column (see Section 5). 

 

 

UniVert Tip: When to Apply System Stiffness Compensation 

Typically, System Stiffness Compensation will not be required.  It may be useful, 
however, when testing stiff specimens that achieve high loads at low displacements.  
Most of the system deformation comes from the load cells which typically strain linearly 
by up to about 200 µm at full scale load.  One can estimate the amount of system 

deformation by multiplying 200 µm by the percent of load cell range that is used.  For 
example, when a load cell is at 50% of its full scale load (a 200N load cell at 100N, or a 
10N load cell at 5N) the system deformation is estimated to be about 100 µm. To 
determine the effect of this displacement on your test you can divide this estimated 
system deformation by the maximum displacement in your test.  For example, in a test 
with 10mm of displacement: 

100 𝑢𝑚

10 𝑚𝑚
=

0.1 𝑚𝑚

10 𝑚𝑚
= 1% 

We recommend using system stiffness compensation if the system deformation is more 
than 10% of the applied deformation. 
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If system stiffness compensation is enabled, a calibration must be performed to determine the 
correct compensation factor.  This factor depends on the load cell being used and a new 
calibration must be completed each time the load cell is changed. There is a software utility to 
automatically perform this calibration. Before starting the software utility, attach the 80 mm riser 
and compression platens to the UniVert system. Also, place the Stiffness Compensation spacer 
that is provided (a small washer) onto the exact center of the lower platen.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

After placing the calibration spacer, jog the platens together 
until there is less than a 1 mm gap between the upper platen 
and the spacer. If this gap is too large, the software utility 
will take a very long time to run.  However, do not allow the 
upper platen and the spacer to come in contact.  If the 
platens are crashed together the load cell will likely be 
damaged. 

 

UniVert Tip: Jog Slowly to Protect Load Cells 

Jog the platens together at a slow speed to prevent 
crashing them together and damaging the load cell.  
Use lower jog speeds the closer the platens are to 
each other. 

 

Stiffness 
Compensation 

Spacer 

80 mm Riser 

Platens 
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To perform system stiffness compensation 
calibration, follow these steps: 
 
 

1. Open the System Stiffness 
Compensation utility by selecting 
Advanced → System Compensation 
from the Tools menu.  

2. Zero the load cells.  
3. Use the jog buttons to decrease the 

gap above the spacer.  Do not 
contact the top of the calibration 
spacer. 

4. Click Run to start the calibration and 
set the stiffness compensation value. 

5. Press OK to Reset Actuators and 
complete the calibration. 

6. The calculated system stiffness 
compensation value will be displayed 

in the message window. 

 
 

 

The calibration utility will slowly drive the platens together until the full-scale load is reached on 
the load cell.  Resulting load displacement data is typically very linear and a best-fit slope is used 
to determine the calibration factor.  Compensation is calculated in compression but is assumed to 
act linearly in both tension and compression. Typical compensation factors are shown in the table 
below: 

 
Load Cell 

Typical Compensation 
(µm/N) 

10 N 11.8 

50 N 2.4 

100 N 1.9 

200 N 1.2 
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Snap Image Feature 

Located under Tools>Snap Image. 

This feature allows the user to capture a single image during the setup phase.  This can be useful 
for documenting specimen loading activity and neutral (non-contact) beam position. 

 

Update Firmware 

Periodic firmware updates may be issued by CellScale for the UniVert. 

1. With the UniVert connected to the PC and turned on, launch the firmware update 
software located in the Windows start menu under UniVert>Utilities. 

2. Load the firmware file using the Load Update File button. 
3. Click the Connect button. 
4. Execute the update using the Update button. 
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9. Troubleshooting 

Communication Errors: Read File failed with error 6. 

When communication errors occur the live message window will display a ReadFile failed 
message. Communication errors can occur if: 

 The UniVert is not powered up. 

 USB cables between the computer and UniVert are disconnected. 

 The supply power surges or is interrupted.  

When a communication error occurs, close UniVert software, check connections, power cycle the 
UniVert Device, and restart the UniVert software.  Be sure to reset the actuators before setting up 
a new test. 

 

UniVert Tip: Preventing Power Disruptions 

We recommend plugging the UniVert (and host computer) into an uninterruptable power 
supply (UPS) or battery back-up. 
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Actuator Limits 

 
While using a test setup with a 40mm riser or no riser beneath the bottom grip or platen, it is 
possible to reach the lower range limit of the actuator.  Hitting the physical range limit may affect 
the accuracy of the Current Size reading. To avoid this, there are several software warnings 
which occur under these circumstances: 
 
Jogging the actuator out of range: 
 

 
 
If the actuator is manually jogged out of the actuator range, a software warning will prompt for the 
actuators to be reset: 
 
 

 
 

Moving the actuator out of range with Move to Size :  
The UniVert software will not allow actuators to be moved to a size outside of the actuator range 
limit. An error message will warn the user of the invalid position and display the minimum 
specified size: 
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Moving the actuator out of range with Move to Force :  
If the actuator is moved past the range limit when using Move to Force the UniVert software will 
display an error message (shown below). It is recommended to perform an actuator reset before 
continuing testing. 
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Reaching the actuator limit during a test:  
If the actuator is moved past the range limit during a test, the UniVert software will terminate the 
test and display an error message: 
 

 
 

 

UniVert Tip: Zero Position Calibration 

Perform a zero position calibration (see Section 8) when the load cell, grips, or risers 
are changed. A correct zero position will ensure that the failsafe features for the 
actuator limits (described above) will work as intended.   
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Appendix A: Unpacking and Initial Setup 

The UniVert has been packed securely to protect it during shipping.  In addition, system 
accessories have been packed in a separate box.  The system components listed below may be 
unpacked and laid out before system setup.  A space 30cm x 30cm with 50cm overhead 
clearance is required for setup. 

Tools 

Metric hex wrenches: 1.5mm, 2.5mm, and 4mm 

Components and Fasteners 

 

1 UniVert Main Unit 

1 Control Box 

1 Base Plate 

1 Load Cell 

2 Calibration Plates 

1 3-Point Bend Rail 

1 3-Point Bending Block 

2 3-Point Bend Slider 

4 3-Point Bend O-Ring (Small) 

2 3-Point Bend O-Ring (Large) 

3 3-Point Bend Dowel (Small) 

3 3-Point Bend Dowel (Large) 

3 Grip Spring (Light) 

3 Grip Spring (Medium) 

3 Grip Spring (Stiff) 

1 M3 Compression Platen (Plastic) 

1  M5 Compression Platen (Plastic) 

2 M5 Compression Platen (Steel) 

1 M3 Low Force Specimen Grip 

2 M5 Low Force Specimen Grips  

2 M5 High Force Specimen Grips  

1  M6 Locking Disc 

1 M5 Locking Disc 

1 M3 Locking Disc 

 

 

1 Camera   

1 Tripod 

1 Actuator Cable   

1 24V Power Supply 

1 6’ (1.8m) USB Cable 

1 M6 to M3 Thumbnut 

1 M6 to M5 Thumbnut 

4 M3x10 Socket Head Cap Screw 

6  M2x6 Socket Head Cap Screw 

4 M3x8 Socket Head Cap Screw 

1 M5x14 Socket Head Cap Screw 

1           M5x55 Socket Head Cap Screw 

1           M5x100 Socket Head Cap Screw 

1           40mm Riser 

1           80mm Riser 

1           Bronze Calibration Spring 

1           Red Calibration Spring 

1           Blue Calibration Spring 

1           Calibration Spacer 

1 Set of extra components 

4           Sample Test Specimens 

1           Stiffness Compensation Spacer 
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Step 1: Unpack all components and have them ready for 
assembly. 
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Step 2: Attach the base plate to the main unit  

(4 x M3x8 fasteners) 
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Step 3: Set the UniVert main unit on the control box and connect 
the actuator cable to the main unit. 
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Step 4: Install the UniVert software. 

See Appendix C: Software Installation for more information. 

 

Step 5: Attach the load cell. 

See Appendix B: Load Cell Installation for this procedure. 

 

Step 6: Attach platens, grips, or 3-point bending components to 
the load cell 

See Appendix D: Test Setup for this procedure 
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Step 7: Connect the UniVert controller and camera USB cables 
to the PC.  Connect the power adapter, load cell cable, USB 
cable, and actuator cable to the control box 

A 24V brick power supply powers the UniVert system via a barrel connector on the back of the 
control box.  The UniVert control box is connected to the PC via a USB 2.0 connection. 

The load cell and actuator connectors have a keyway inside the connector and a locking ring to 
ensure proper connection. To connect a load cell or actuator cable align the keyway, push the 
connector in, and turn the locking ring until tight.  Note that the load cell connector only requires 
about ¼ turn to lock in place while the actuator cable has a threaded connection and requires 
several turns to lock in place. 

 

 

USB Connection 

Power Connection Actuator Connection 

Load Cell 
Connection 
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Step 8: Launch the software and begin a test to ensure the 
UniVert loads up normally. 

Run UniVert.exe and start a new test (File > Collect New). The software will output information on 
the initialization of the camera, load cell, and actuator. The software will output System Ready! 
when all systems have loaded and the UniVert is ready for testing. 

 

 

 

Step 9: Calibrate the Load Cell 

See Section 8 of the User’s Manual for more information. 

 

Step 10: Set the Actuator Zero Position 

See Section 8 of the User’s Manual for more information. 

 

Step 11: Begin Testing 

It is recommended that the User’s Manual be thoroughly reviewed before beginning testing using 
the UniVert system.  Procedures for loading samples, setting up tests, carrying out tests, and 
reviewing results are described in detail. 
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Appendix B: Load Cell Installation 

In order to avoid load cell damage, proper installation is required. Follow these steps when 
changing load cells or installing for the first time: 

1. Identify the active end of the load cell (see below image).  This is the MEASURING END 
of the load cell which results in a force reading.  This end is covered with a small plate 
not continuous with the rest of the load cell body. 

 

 

2. Attach the appropriate thumbnut to the NON-MEASURING END of the load cell (M5 or 
M3 depending on the load cell). 
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3. Screw the load cell/thumbnut combination onto the actuator. At this point the 
measuring end of the load cell should be facing down, and the non-measuring end 
attached to the thumbnut and actuator. 
 
An M6 locking disc may be used between the thumbnut and actuator so the rotational 
position of the load cell can be changed while maintaining snug attachment. 
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Appendix C: Software Installation 

A Windows based PC (Windows 7 or above) with at least 2 USB 2.0 ports is required to operate 
the UniVert.  A label on the cover of the manual contains a web address to download the UniVert 
software installation package. These files contain the software installer for the user interface and 
control software for the UniVert.   

To install the software, go to the provided web address and download the compressed installation 
package.  Transfer this file to the computer which will be running the UniVert.  Right click on the 
folder and select Extract All… to unzip.  After this is complete, go to the uncompressed 
installation folder and select setup.exe.  Details of typical dialogue boxes are shown below. 
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UniVert User Manual 

69 
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Appendix D: Test Setup 

Choosing and installing a Riser for the Bottom Grip, Platen, or 3 
Point Bend Block 

40mm and 80mm risers are included with the UniVert system.  These are placed between the 
bottom of the main unit and the lower platen, grip, or 3-point bending block. The risers are used to 
set the available specimen size for testing.  Due to the limitations of maximum stroke of the 
actuator, each riser (or no riser) will have correspond to a minimum sample size.  

 Using a 40mm riser requires a minimum sample size of about 40mm.  

 Using NO riser requires a minimum sample size of about 80mm. 
 

 

 

UniVert Tip: Choosing an appropriate riser 

The UniVert system can accommodate large samples when using the 40mm riser or no 
riser. Use a 40mm riser or no riser for large samples or tests that require large 
displacements. 

 

After selecting a riser follow these installation steps: 

1. Carefully place the UniVert motor housing on its side. 
 

2. Select the M5x100 fastener for an 80mm riser, the M5x55 fastener for a 40mm riser or 
an M5x14 fastener when not using a riser. (Note: Two M5 washers must be used when 
using the M5x100 fastener and the 80mm riser.) 
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3. Thread the appropriate fastener through the bottom of the base plate and slide the 
corresponding riser on top. 
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4. Continue with a test setup procedure using the grips, platens, or 3-point bend blocks.  
This is outlined below.  

 

Tension Test Setup 

1. Set the test mode to Tension (Settings>Test Mode>Tension). This setting is specific to 
the test template being used and can be saved to a template. 
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2. Install the desired load cell (see Appendix B) and select the appropriate riser (see 
above) 
 

3. Screw a locking disc onto the measuring end of the load cell. Select either an M5 or M3 
locking disc based on the load cell. 
 

 

 

4. Screw the appropriate grip onto the measuring end of the load cell after the locking disc.  
Tightening the locking disc against the grip allows the grip to be secured to the actuator 
at any rotational position. 
 
Finger tighten all components.  Beware of exerting excessive off-axis and 
torqueing forces to avoid damage to the load cell. 
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5. Choose an appropriate riser and attach the bottom grip. Use an M5x14 fastener for a test 
setup with NO riser, a M5x55 fastener for a 40mm riser, and an M5x100 fastener for the 
80mm riser. (Note: Two washers will be needed on the M5x100 fastener when using the 
High Force Grips) 
 

6. Align the two grips until they are parallel. 
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7. A Zero Position Calibration is required after changing grips or platens.  See Section 8 of 
this manual for more details. 
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Compression Test Setup 

1. Set the test mode to compression (Settings>Test Mode>Compression).  This setting is 
specific to the test template being used and can be saved to a template. 

 

 
 

 
2. Install the desired load cell (see Appendix B) 

 
3. Attach the compression platen directly to the measuring end of the load cell. Choose an 

M5 or M3 platen depending on the load cell. 
 
Finger tighten all components.  Beware of exerting excessive off-axis and 
torqueing forces to avoid damage to the load cell. 
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4. Choose an appropriate riser and attach the bottom platen. Use an M5x14 fastener for a 
test setup with NO riser, a M5x55 fastener for a 40mm riser, and an M5x100 fastener for 
the 80mm riser. 
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5. A Zero Position Calibration is required after changing grips or platens.  See Section 8 of 
this manual for more details. 
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3-Point Bend Test Setup 

1. Set the test mode to compression (Settings>Test Mode>Compression). 
 

 

 

2. Install the desired load cell (see Appendix B) 
 

3. Attach a locking disc to the measuring end of the load cell. 
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4. Assemble the 3-Point Bending Block and sliders using M2x6 fasteners, M3x10 fasteners, 
large O-Rings and small O-Rings as illustrated below (Note: Choose a dowel size 
appropriate for the test being performed). 
 

 

 
5. Screw the bending block onto the measuring end of the load cell and tighten in the 

correct position using the locking disc. 
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Finger tighten all components.  Beware of exerting excessive off-axis and 
torqueing forces to avoid damage to the load cell. 

 

6. Attach and align the 3-Point bend rail onto the bottom of the motor housing using an 
M5x100 fastener and 80mm riser. 

 

 

 

7. Secure both sliders onto the rail in the desired position by tightening the fasteners. 
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Appendix E: Camera Setup 

Webcam 

The webcam included with the UniVert system is used for recording images at up to 5Hz.  The 
UniVert will function with or without the camera plugged in. To setup the camera, follow these 
steps: 

1. Before starting the UniVert software, plug the webcam into a USB port. 
 

2. Thread the tripod into the mounting hole on the bottom of the camera. 
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3. Set the camera in the desired recording position using the flexible tripod. 
 

 

 

4. Refer to Section 7: System Hardware Settings for additional camera settings.  
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Scientific Camera  

The scientific camera, an optional add-on to the UniVert system, is used for recording images at 
up to 15Hz and is compatible with the image tracking feature of the software. To setup the 
camera, follow these steps: 

1. Before starting the UniVert software, plug the camera into a USB port. Have the UniVert 
software open while performing camera setup so that the live video can be monitored. 

 
2. Thread the tripod into the mounting hole on the bottom of the camera. 

 
 

3. Thread the lens onto the camera with a 5mm spacer in place (already attached to the 
camera upon system delivery) 

 

 

  

5mm Spacer 
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4. Place the ringlight on the end of the lens. Lock it in place using the thumb screws. 
Brightness level can be controlled by the dial on the power supply. 
 

 
 

5. Bring the camera to the desired height by adjusting the separation of the tripod legs. Note 
that working distance from specimen to lens should be at least 15cm. 
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6. The image brightness can be 
adjusted using the Iris Ring on the 
lens. It is recommended to leave 
the Iris Ring fully open and control 
image brightness with the ringlight 
and the Hardware Settings in the 
software (see Section 7). 
 

7. Obtain desired magnification level 
by manually adjusting the W – T 
ring on the lens. 

 

8. Bring the image to optimum focus 
by manually adjusting the F – N 
ring on the lens. 
 

9. Use the thumb screws on each of 
the lens rings to lock them at the 
desired settings. 

 

 

 

Iris Ring 

W – T Ring 

F – N Ring 
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Appendix F: Changing Grip Springs 

The grips used for tension testing come in three different gripping strengths to suit different 
materials and tests. Replacement springs of varying stiffness are provided with the UniVert and 
these may be switched at any time using the hook tool provided. The light, medium and heavy 
springs will provide 1.5N, 6N, and 15N of gripping force respectively.  

To change a grip spring follow these steps: 

1. Using the hook tool provided, pull on the spring and remove the metal dowel holding the 
grip spring in place. The spring is free to be removed after this step. 
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System Alert 

A fully installed spring experiences a high amount of tension.   When the springs are 
disengaged, be sure not to let the hook tool slip or the spring may be released at high 
velocity. The use of safety glasses is recommended. 

 

 
2. Replace the old spring with a new spring of the desired tension. 

 
3. Secure one side of the spring onto the grip with a metal dowel. 

 

4. With one hand use the hook tool to pull the other side of the spring into place and secure 
with another metal dowel (Note: This step may be easier with two people) 
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